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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between service provider CenturyLink using Sonus switch and Avaya IP
Office 9.0.3

CenturyLink SIP Trunk Service (CenturyLink) provides PSTN access via a SIP trunk between
the enterprise and the CenturyLink network as an alternative to legacy analog or digital trunks.
This approach generally results in lower cost for the enterprise.

CenturyLink is a member of the Avaya DevConnect Service Provider program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 10f32
SPOC 8/7/2014 ©2014 Avaya Inc. All Rights Reserved. CTLSipIP0O903



1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between CenturyLink and Avaya IP Office solution. In the sample configuration, the
Avaya IP Office solution consists of an Avaya IP Office 500v2 Release 9.0.3, Avaya embedded
Voicemail, Avaya IP Office Softphone, Avaya Flare® Experience for Windows, Avaya H.323,
Avaya SIP, digital and analog endpoints.

The CenturyLink referenced within these Application Notes is designed for business customers. The
service enables local and long distance PSTN calling via standards-based SIP trunks as an alternative
to legacy analog or digital trunks, without the need for additional TDM enterprise gateways and the
associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office
connecting to CenturyLink.

This configuration (shown in Figure 1) was used to exercise the features and functionality tests
listed in Section 2.1. Note: NAT devices added between Avaya IP Office and the CenturyLink
network should be transparent to the SIP signaling.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya IP Office was connected to CenturyLink. To verify SIP
trunking interoperability, the following features and functionality were exercised during the
interoperability compliance test:

e Incoming PSTN calls to various phone types. Phone types included H.323, SIP, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included H.323, SIP, digital,
and analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls from/to the Avaya IP Office Softphone/ Avaya Flare®
Experience for Windows (SIP).

e Inbound and outbound long hold time call stability.

e Various call types including: local, long distance, international call, inbound toll-free,
outbound toll-free, operator assisted call, 411 and 911 services.

e Codec G.729A and G.711U.

e Caller number/ID presentation.
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Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

DTMF transmission using RFC 2833.

Voicemail navigation for inbound and outbound calls.

Telephony features such as hold and resume, transfer, and conference.

FAX using T.38 and G.711 pass-through.

Off-net call forwarding (CenturyLink supports Diversion Header).

Twinning to mobile phones on inbound calls.

2.2. Test Results

Interoperability testing of CenturyLink was completed with successful results for all test cases with
the exception of the observations/limitations described below.

CenturyLink does not send OPTIONS but response to IP Office OPTIONS with
2000K. CenturyLink will send OPTIONS if customer request/order it.

Blind Call Transfer to PSTN using Avaya 1140E SIP phone does not complete until
transferee picks up the call — Call scenario is when PSTN phone calls to Avaya 1140E SIP
phone, Avaya 1140E SIP phone answers the call and performs blind transfer to another
PSTN endpoint. The expected behavior of Avaya 1140E SIP phone is after transfer, the
phone should display “transfer completed”. But in this case, user presses “transfer” button,
answers question of “Consultative transfer with party ?”” with “No”, which implies the blind
transfer, as the transferee PSTN phone is ringing, the Avaya 1140E SIP phone should be
released and display “transfer successfully”. Instead, the Avaya 1140E SIP phone still
displays “transferring” and not released until the transferee PSTN phone answers the call.
The work around is to hang up the Avaya 1140E SIP phone. This is very minor known
limitation on Avaya 1140E SIP phone. There is no user impact. Transfer is still completed
with 2 ways audio.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit:
http://support.avaya.com

For technical support on the CenturyLink system, please visit: http://www.centurylink.com

3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to CenturyLink through the public IP network. For confidentiality and privacy purposes,
actual public IP addresses used in this testing have been masked out and replaced with fictitious IP
addresses throughout the document.

Located at the enterprise site is an Avaya IP Office 500v2 with the MOD DGTL STA16 expansion
module which provides connections for 16 digital stations to the PSTN, and the extension PHONE 8
card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM
(Voice Compression Module) for supporting VolP codecs. The voicemail service is embedded on
Avaya IP Office. The LAN2 port of Avaya IP Office is connected to the public IP network.
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Endpoints include Avaya 9600 Series IP Telephone (with H.323 firmware), Avaya 1100 Series IP
Telephone (with SIP firmware), Avaya 1408D Digital Telephones, Avaya Analog Telephone, Avaya
Flare® Experience for Windows, and Avaya IP Office Softphone H.323. A separate Windows XP PC
runs Avaya IP Office Manager to configure and administer Avaya IP Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user’s
phones will also ring and can be answered at the configured mobile phones.

( , 10.10.97.X 0
33
Avaya IP Office 500
V2 Release 9.0.3 = A
Embedded Voicemail ~ .40 \ g I @ -
Avaya 9600  Avaya 1140E 1P Office
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(H.323) Manager
Avaya Flare®
Analog  pax - Digial Experience For
Phone Phone X
Windows (SIP)
A
( 10.10.98.X )
DevConnect Test LAB
Enterprise site
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Internet CenturyLink

Network Cloud

Session Trunk Group IP Address: 192.168.33.8 (For incoming calls)
Usage Trunk Group IP Address: 192.168.33.9 (For outgoing calls and incoming toll free calls)
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Figure 1: Test Configuration for Avaya IP Office with CenturyLink SIP Trunk Service

For the purposes of the compliance test, Avaya IP Office users dialed a short code of 5 + N digits to
send digits across the SIP trunk to CenturyLink. The short code of 5 was stripped off by Avaya IP
Office but the remaining N digits were sent unaltered to CenturyLink. For calls within the North
American Numbering Plan (NANP), the user would dial 11 (1 + 10) digits. Thus for these NANP
calls, Avaya IP Office would send 11 digits in the Request URI and the To field of an outbound SIP
INVITE message. It was configured to send 10 digits in the From field. For inbound calls,
CenturyLink sent 10 digits in the Request URI and the To field of inbound SIP INVITE messages.
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In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the Avaya IP Office such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond the
scope of these Application Notes. However, it should be noted that SIP and RTP traffic between the
service provider and the Avaya IP Office must be allowed to pass through these devices.

4. Equipment and Software Validated
The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment Release
Avaya IP Office 500v2 9.0.3 (Build 941)
Avaya IP Office DIG DCP*16 V2 9.0.3 (Build 941)
Avaya IP Office Ext Card Phone 8 9.0.3 (Build 941)
Avaya IP Office Manager 9.0.3 (Build 941)
Avaya 1140E IP Telephone (SIP) 04.04.12.00
Avaya IP 9640G S3.2
Avaya IP 9630 S3.2
Avaya IP Office Softphone 3.2.3.49 68975
Avaya Flare® Experience for Windows (SIP) 1.1.4.23 SP4
Avaya Digital Telephone (1408D) N/A
Avaya Symphony 2000 Analog Telephone N/A
HP Officejet 4500 (fax) N/A

CenturyLink Components

Equipment Release

Sonus NBS 7.3.7

Note: Testing was performed with IP Office 500 v2 R9.0.3, but it also applies to IP Office Server
Edition R9.0.3. Note that IP Office Server Edition requires an Expansion IP Office 500 v2 R9.0.3 to
support analog or digital endpoints or trunks. IP Office Server Edition does not support TAPI Wave
or Group Voicemail.
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5. Configure IP Office

This section describes the Avaya IP Office configuration to support connectivity to CenturyLink.
Avaya IP Office is configured through the Avaya IP Office Manager PC application. From a PC
running the Avaya IP Office Manager application, select Start - Programs - IP Office >
Manager to launch the application. Navigate to File > Open Configuration, select the proper
Avaya IP Office system from the pop-up window, and log in with the appropriate credentials. A
management window will appear similar to the one shown in the next section. The appearance of the
IP Office Manager can be customized using the View menu. In the screens presented in this section,
the View menu was configured to show the Navigation pane on the left side, the Group pane in the
center, and the Details pane on the right side. These panes will be referenced throughout the Avaya
IP Office configuration. Proper licensing as well as standard feature configurations that are not
directly related to the interface with the service provider (such as the LAN interface to the enterprise
site and IP Office Softphone support) is assumed to be already in place.

5.1. LAN2 Settings

In the sample configuration, the IPOffice_1 was used as the system name and the LAN2 port was
used to connect to CenturyLink. To access the LAN2 settings, first navigate to System (1) >
IPOffice_1 in the Navigation and Group Panes and then navigate to the LAN2-> LAN Settings tab
in the Details Pane. Set the IP Address field to the IP address assigned to the Avaya IP Office LAN
port. Set the IP Mask field to the mask used on the public network. All other parameters should be
set according to customer requirements. Click OK to submit the change.

IP Offices System

&R BOOTP (8) Name

4 Operator (3) “IPOffice_t
47 ine (3)
<= Control Unit (4)
& Extension (29)
2 User(2p)
% Group (1)
B Short Code (60)
B s

o, RAS (1)
Incoming Call Route (4)

€2 wanPort (0)
o Directory (0)
£7) Time Profile (0)
@ Firewall Profile (1)
B 1P Route (3)
& Account Code (0)
. License (30

@& Tunnel (0)
§3 User Rights (10)
188 Auto Attendant (0)

€ RS (2)

i Location (0)

Ei IPOffice_1*

RAKAES

System | Lan1 |[LANZ| |DNS | voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | ¥cM | CCR | Codecs

LAN Settings| | voIP | Metwork Topology

1P Address 10 10 98 14

1P Mask. 255 . 255 . 255 0

Primary Trans. IP Address 0 0 0 0

Firewall Profile | <Mone> v

RIP Mode |none v
[[] Enable NaT

Number Of DHCP IP Addresses (200 &
DHCP Mode:

O server O client O Dialin (& Disabled Advance

The VolIP tab as shown in the screenshot below was configured with following settings.
e Check the H323 Gatekeeper Enable to allow Avaya IP Telephones/Softphones using the

H.323 protocol to register.

e Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to

CenturyLink.

e Check the SIP Registrar Enable to allow Avaya IP Telephones/Softphones to register using

the SIP protocol.
e Input Domain Name as 10.10.98.14.

e The Layer 4 Protocol use UDP with port 5060 and TCP with port 5060.
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e Verify the RTP Port Number Range settings for a specific range for the RTP traffic. The

Port Range (Minimum) and Port Range (Maximum) values were kept as default.
e Check Enable RTCP Monitoring on Port 5005.
e Verify RTP Keepalives settings were enabled with Scope as RTP, Periodic timeout in 30
seconds, and Initial keepalives as Enabled. This allows IP Office to send IP packets to keep

the active RTP session alive in every 30 seconds if there is no audio detected on the SIP

Trunk.

o Verify the DiffServ Settings were kept as default for the Differentiated Services Code Point

(DSCP) parameters in the IP packet headers to support Quality of Services policies for both

signaling and media, the DSCP field is the value used for media and the SIG DSCP is the

value used for signaling.

e All other parameters should be set according to customer requirements.

e Click OK (not shown).

7

IPOffice_1* BY - v

‘ System I LANL ||LAN2 | DNS I Voicemail l Telephony l Directory Services I System Events | SMTP I SMDR ’ Twinning ] VCM I CCR | o

[LAN Sétfing.s_-j Lrl\l»etwork Topology |

| [¥] H323 Gatekeeper Enable |
[7] Auto-create Extn

7| SIP Trunks Enable

[7] SIP Registrar Enable

[¥] Auto-create Extn/User

Auto-create User

[7] H323 Remote Extn Enable

[7] SIP Remote Extn Enable

Domain Name 10.10.98.14
[¥] ubp UDP Port 5060 = Remote UDP Port 5060
Layer 4 Protocol [¥] TCP TCP Port /5060 2 Remote TCP Port 5060
[ TLs TLS Port 5061 2 Remote TLS Port 5061
Challenge Expiry Time (secs) 10 S
RTP
Port Number Range
Minimum 49152 = Maximum 53246 =
Port Number Range (NAT)
Minimum 49152 2 Maximum 53246 5
[¥] Enable RTCP Monitoring on Port 5005 I
Keepalives
Scope [RTP VI Periodic timeout 30

Initial keepalives [Enabled

%)

DiffServ Settings

B3 = DSCP(Hex) B8 S

Video DSCP(Hex) FC -

DSCP Mask (Hex) 88

<

> SIG DSCP (Hex)

I

-

m
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On the Network Topology tab in the Details Pane, configure the following parameters:

o Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

e Set the Binding Refresh Time (seconds) to 60. This value is used as one input to determine
the frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider.

e Set Public IP Address to the IP address of the Avaya IP Office LAN2 port.

e Set Public Port for UDP as 5060.

e All other parameters should be set according to customer requirements.

e Click OK (not shown).

| IPOffice_1* = | {2

System | LAM1 | [LANZ| ' DNS || Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | ¥CM | CCR || Codecs

LAN Settings | VoIP | |MNetwork Topology

Metwork Topology Discovery

STUM Server Address [192.168.10.13 STUN Port 3478 3
Firewall[NAT Type ;Open Internet v |
Binding Refresh Time {seconds) 60 |

Public IP Address 10 10 98 14 Run STUN Cancel

Public Port
LDP |S060

TCP o

R

TLS |0

[] rRun STUN on startup

In the compliance test, the LANL1 interface was used to connect the Avaya IP Office to the enterprise
site IP network. The LANL interface configuration is not directly relevant to the interface with
CenturyLink, and therefore is not described in these Application Notes.
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5.2. System Telephony Settings

Navigate to System (1) > IPOffice_1 in the Navigation and Group Panes and then navigate to the
Telephony = Telephony tab in the Details Pane. Choose the Companding Law typical for the
enterprise location. For North America, U-Law is used. Uncheck the Inhibit Off-Switch
Forward/Transfer box to allow call forwarding and call transfers to the PSTN via the service
provider across the SIP trunk. Set Hold Timeout (secs) to 600. Click OK to submit the change.

£ IPOffice_1* i -8 | X | v <]

System | LANI I LANZ iDNS i‘ Yoicemail | [Telephony »Directory Services I System Events | SMTP I SMDR rTwinning {l VM VCCR I Codecs
|| Telephony| | Park & Page | Tones &Music | Ring Tones | SM | Call Log | TUI

~
Analogue Extensions -
I = Switch Line
Default Outside Call Sequence | Mormal v |
Default Inside Call Sequence {Ring Type 1 v © U-taw © U-Law Line
Default Ring Back Sequence :Ring Type 2 v :
= = O A-Law O A-Law Line
Restrict Analogue Extension Ringer Yoltage O
Dial Delay Time {secs) 4 e, } [] pss Status
Dial Delay Count b & Aol
Default Mo Answer Time (secs) |15 & ‘ Dial By Name
‘ Hold Timeout (secs) 5500 = ' SHaw fccounk: Code
T b B ] tnhibit OFf-Switch Forward/Transfer |
ark Timeout {secs s v
Ring Delay ) 5 : .\” D Restrict Metwork Interconnect
ing Delay (secs 3 v

= [] prop External Only Impromptu Conference

Call Priority Promotion Time {secs) ?Di’s;ﬁlreai = ‘
as ey [] wisually Differentiate External Call
Default Currency |UsSD v
== = [] unsupervised analog Trunk Disconnect Handling
Default Name Priority | Favor Trunk v
S — — High Quality Conferencing
Media Connection Preservation | Disabled v
[[] strict s1PS
Digital/Analogue Auto Create User
M|
[ QK ] [ Cancel ] [ Help ]
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5.3. System Codec Settings

Navigate to System (1) > IPOffice_1 in the Navigation and Group Panes and then navigate to the
Codecs tab in the Details Pane. Choose the RFC2833 Default Payload as IP Office default of 101.
Select codecs G.711 ULAW 64K and G.729(a) 8K CS-ACELP that CenturyLink supports. Click
OK to submit the change.

| = IPOffice_1 B -

system | LaN1 | Lanz | DNS | Voicemail | Telephony | Directory Services || System Events | sMTP | DR | Twinning | vcm | ccr  f Codecs |
RF(C2833 Default Payload 101 =

Available Codecs Default Codec Selection

e ) Unused Selected

Gi711 ULAW 64 ‘ G.711 ALAW 64K ‘ > |G.711 ULAW 64K

AT ARG G.723.1 6K3 MP-MLQ |G.729(a) 8K C5-ACELP

[] G.722 64k

G.729(a) 8K C5-ACELP
G.723.1 6K3 MP-MLQ

M
FAS
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5.4. Twinning Calling Party Settings

When using twinning, the calling party number displayed on the twinned phone is controlled by two
parameters. These parameters only affect twinning and do not impact the messaging or operation of
other redirected calls such as forwarded calls. The first parameter is the Send original calling party
information for Mobile Twinning box on the Twinning tab, as shown below. The second
parameter is the Send Caller ID parameter on the SIP Line form (shown in Section Error!
Reference source not found.).

If Send original calling party information for Mobile Twinning on the Twinning tab is optioned,
the setting of the second parameter is ignored and Avaya IP Office will send the following in the SIP
From Header:
e On calls from an internal extension to a twinned phone, Avaya IP Office will send the calling
party number of the originating extension.
e On calls from the PSTN to a twinned phone, Avaya IP Office will send the calling party
number of the host phone associated with the twinned destination (instead of the number of
the originating caller).

If this option is unchecked, the value sent in the SIP From header is determined by the setting of the
second parameter mentioned above.

e For the compliance test, the Send original calling party information for Mobile Twinning
box in the System—>Twinning tab was unchecked. The value sent in the SIP From header is
determined by the setting of the Send Caller ID parameter on the SIP Line form.

IPOffice_1

System | LaN1 | LAz | DNS | Voicemail | Telephony | Directory Services | System Events | smTP | smpR |[Twinning | vem | ccr | Codecs

| [] send original calling party information For Mobile Twinning |

Calling party information For
Maobile Twinning
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5.5. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and CenturyLink SIP
Trunk service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP Office
Manager to create a SIP Line. Follow the steps in Section 5.5.1 to create the SIP Line from the
template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

IP addresses.

SIP Credentials (if applicable).

SIP URI entries.

Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section Error! Reference source not found..

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.

Alternatively, a SIP Line can be created manually. To do so right-click Line in the Navigation Pane
and select New => SIP Line. Then, follow the steps outlined in Section Error! Reference source not
found..

For the compliance test, SIP Line 17 was used as trunks for incoming calls and SIP Line 18 was used
as trunks for outgoing and incoming toll-free calls.

5.5.1. Create SIP Line from Template.

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to CenturyLink_17.xml (for SIP Line 17) and CenturyLink_18.xml (for SIP
Line 18). The file name is important in locating the proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File = Preferences. In the IP Office Manager Preferences window that appears,
select the Visual Preferences tab. Verify that the box is checked next to Enable Template
Options. Click OK.
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Preferences | Directories | Discovery Security | Validation
‘ ; = \
Icon Size | Small v |
Multiline Tabs
l Enable Template Options |

i) \ OK Cancel I [ Help J

3. Import the template into IP Office Manager. From IP Office Manager, select Tools =
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down
menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

File  Edit View | Tools ||Help

A | :’l Extension Renumber. ..
: DevCon IPO 2 Line Renumber... = ]
Connect To... % > : " ) |
SIP Line - Line 19 ek -E X vi<|>
Export »
& K BOOTP (%) SCN Setvice User Management RI|volP | 738 Fax/SIP Credentials
[+ {7 Operator (3) ¥ - ) A
DevCon IPO 2 Busy on Held Yalidation Check 005 |
%7 System (1) < Fra = b
=47 Line (9) MSM Configuration | Call Routing Method Request URI M
- r | ' e s ol | Im
17 Import Templates in Manager = ] i ‘ ‘

In the pop-up window (not shown) that appears, select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window (not
shown) will appear stating success or failure. Then click OK (not shown) to continue. If
preferred, this step may be skipped if the template file is copied directly to the IP Office
template directory.

4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New = New SIP Trunk From Template.
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IP Offices PRI 24 (Universal) -Line 1

R BOOTP(8) Line Mumber  Line Type Line § ||
47 Operator (3) 0 SIP Line :
5 : H32é 7 - Line SubType |71 v
. ine = -
TR %1 cut Chrl+x 1P DECT Line | |
0 E el copy CirlsC SIP Line Admin |In Service o i
§ ui@ll r- - SM Line . <
2 :; 7| Delete Ctrl+Del SIP DECT Line ]
m sd \/1 validate | Mew SIP Trunk From Template |k = ! . -
oAy | & 2 : TR Quany ETOrk. | Framing ESF v
@ In| New from Template (Binary) CRC Checking Zero Suppression |B8ZS v ‘
W] T
Eg Di Show In Groups CSU Operation O Line Signalling CPE ¥
T : L
@ : e Haul Length |0-115 ft v Incoming Routing Digits |4
i ustomize Columns. .. —
E ‘I: | Change Universal PRI Card Line Type > Channel Unit |Foreign Exchange |
S, License (30) -l

5. In the subsequent Template Type Selection pop-up window, select United States from the
Country pull-down menu and select CenturyLink_17 or CenturyLink_18 from the
Service Provider pull-down menu as shown below. These values correspond to parts of the
file name (CenturyLink_17.xml and CenturyLink_18.xml) created in Step 1. Click
Create new SIP Trunk to finish creating the trunk.

] Template Type Selection

Locale Inited States (US Endlis!
Country | United States v}
Service Provider l CenturyLink_17 v} [] Display &l

[ Create new SIP Trunk ] [ Cancel ]

-
] Template Type Selection

Locale Inited States (US Endlis!
Country | United States v}
Service Provider ECenturyLink_18 v‘ [] Display &l

[ Create new SIP Trunk ] [ Cancel ]

6. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Section 5.5.2.
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5.5.2. Create SIP Line Manually for Incoming Calls

To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the
Group Pane and select New - SIP Line.

On the SIP Line tab in the Details Pane, configure the parameters as shown below:

e Set ITSP Domain Name to the IP address of CenturyLink signaling server (Session Trunk
Group) 192.168.33.8.

e Check the In Service box.

e Set URI Type to SIP.

e Set Call Routing Method to Request URI.
e Check Caller ID from From header box.

e Set Send Caller ID to None.

e Set Association Method to By Source IP address.

e Set Service Busy Response as 503 — Service Unavailable.

e Check REFER Support to enable SIP REFER for call transfers. Select the default values of

“Auto” for Incoming and Outgoing to use of SIP REFER effectively.

e Set Method for Session Refresh to Reinvite with Session Timer (seconds): 1200. If the
Method for Session Refresh set to the default value “On Demand”, then IP Office does not
initiate Session Timer and only supports it if it is initiated by the other side.

e Default values may be used for all other parameters.

e Click OK to commit (not shown) then press Ctrl + S to save.

IP Offices | Line i= SIP Line - Line 17 o -B x| v«
& BoOTP (5) Line Numbey;|jtine Type ([ Line] ransport|sip uRI|velP [738 Fax|sIP Credentials
4 Operator (3) 1 PRI 24 (Universal) 3
= Poffce L ” 2 PRI24 (Universal) ||| Line Number B .
[ Line @) oy, StB Hine ‘ TSP Domain Name 102168338 ‘ [in Service 7]
<= Control Unit (4) 18 SIP Line e ——
& Extension (29) ’URIType s -
i User (26)
2% Group (1) Prefix Check 00S |
8% Short Code (60)
@ Service (0) National Prefix | Call Routing Method Request URI v l
% IRAS o i Originator number for
g \;Zi‘m;"?tig) oute (6) Country Code forwarded and twinning calls
=l —_—
@& Directory (0) International Prefix Name Priority System Default |
£7) Time Profile (0)
@ Firewall Profile (1) Send Caller ID [None v]‘ ‘ Caller ID from From header V] |
@ 1P Route 3)
am Account Code (0) Association Method {By Source IP address 'J| Send From In Clear

% License (30) User-Agent and Server

@& Tunnel (0) Headers

§4 UserRights (10)
88 Auto Attendant (0) {Sewice Busy Response (503 - Service Unavailable  ~ l|
‘¢ ARS () : e
i Location (0) Action on CAC Location Limit | Allow Voicemail v]
[¥] REFER Support
Incoming ‘Auto V]
Outgoing [Auto -
Method for Session Refresh ‘ Reinvite ']
Session Timer (seconds) 1200
Media Connection Preservation [Disabled -
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On the Transport tab in the Details Pane, configure the parameters as shown below:

e The ITSP Proxy Address was set to the IP Address of CenturyLink signaling server (Session
Trunk Group) 192.168.33.8 as shown in Figure 1.

¢ Inthe Network Configuration area, UDP was selected as the Layer 4 Protocol and the Send
Port was set to 5060 which is the port number provided by CenturyLink.

e The Use Network Topology Info parameter was set to LAN 2. This associates the SIP Line 17
with the parameters in the System - LAN2 - Network Topology tab.

e The Calls Route via Registrar was unchecked. In this certification testing, CenturyLink did
not support the dynamic Registration on the SIP Trunk.

e Other parameters retain default values.

e Click OK to commit (not shown) then press Ctrl + S to save.

= SIP Line - Line 17 i

SIP Line)Transport|SIP URI|VolP |38 Fax|SIP Credentials|

ITSP Proxy Address 192.168.33.8

| | Network Configuration
Layer 4 Protocol [UDP vl Send Port 5060 %
Use Network Topology Info | LAN 2 v] 5060
Explicit DNS Server(s) 0 0 0 0 0 0 0 0

Calls Route via Registrar [ ‘

Separate Registrar
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A SIP URI entry must be created to match each incoming number that Avaya IP Office will accept
on this line. Select the SIP URI tab; click the Add button and the New Channel area will appear at
the bottom of the pane (not shown). To edit an existing entry, click an entry in the list at the top, and
click Edit... button. In the example screen below, a previously configured entry is edited. For the
compliance test, a single SIP URI entry was created that matched any DID number assigned to an
Avaya IP Office user. The entry was created with the parameters shown below:

e Set Local URI, Contact, Display Name, and PAI to Use Internal Data. This setting allows
calls on this line which SIP URI matches the number set in the SIP tab of any User as shown
in Section 5.7.

e Set Registration to 0: <None> as CenturyLink does not require registration.

e Associate this line with an incoming line group in the Incoming Group field. This line group
number will be used in defining incoming call routes for this line. For the compliance test, a
new incoming group 17 was defined that only contains this line (line 17).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

e Click OK to submit the changes.

= SIP Line - Line 17

ESIP LinelTransportl SIP URI {VoIP |T38 FaxlSIP Credentialsi
Channel Groups Via Local URI Contact Display Name PAI Credential Max Calls Add...
1 17 0 2 P 0: <Non... 20

Remove
Edit...

Edit Channel
Via 10.10.98.14
Local URI Use Internal Data - Cancel l
Contact Use Internal Datal -
Display Name Use Internal Data -
PAI Use Internal Data| -
Registration [0: <None> V]
Incoming Group 17
Outgeing Group 0
Max Calls per Channel 20 -
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,

allowing an explicit ordered list of codecs to be specified. Selecting G.711 ULAW 64K, and

G.729(a) 8K CS —ACELP codecs causes Avaya IP Office to support these codecs, which are

sent by the CenturyLink, in the Session Description Protocol (SDP) offer, in that order.

Uncheck the VVolIP Silence Suppression box.

Check the Re-invite Supported box.

Check Codec Lockdown.

Set Fax Transport Support to T38 or G.711 from the pull-down menu. CenturyLink

supports both Fax T.38 and Fax G.711 pass-through modes.

e Setthe DTMF Support to RFC2833 from the pull-down menu. This directs Avaya IP
Office to send DTMF tones using RTP events messages as defined in RFC2833.

e Default values may be used for all other parameters.

e Click OK (not shown) to submit the changes.

i= SIP Line - Line 17 ek X | v

|SIP Line|Transport|SIP URI|VoIP | 738 Fax|SIP Credentials

[ [ VolIP Silence Suppression]
[] Allow Direct Media Path
Codec Selection [Custom vl I [¥] Re-invite Supported l
Unused Selected =
|¥| Codec Lockdown
G.711 ALAW 64K >33 G.711 ULAW 64K
(.723.1 6K3 MP-MLQ G.729(a) 8K CS-ACELP ] ["] PRACK/100rel Supported
Force direct media with phones
[7] G.711 Fax ECAN
Fax Transport Support [G.711 vH
Location [Cloud v]
Call Initiation Timeout (s) 4
DTMF Support |RFC2833 -
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5.5.3. Create SIP Line Manually for Outgoing Calls

On the SIP Line tab in the Details Pane, configure the parameters as shown below:

e Incoming Call Route (6)
£ WAN Port (0)

2= Directory (0)

£ Time Profile (0)
@ Firewall Profile (1)
K@l 1P Route 3)

@ Account Code (0)
% License (30)

¥ Tunnel (0)

§5 UserRights (10)
@8 Auto Attendant (0)
‘K ARS (2)

B Location (0)

Country Code

International Prefix

Originator number for
forwarded and twinning calls

Name Priority

System Default v

Send Caller ID

[Diversion Header

)

| |Association Method

By Source IP adaress

Session Timer (seconds)

[¥] REFER Support

Incoming [Auto ']
Outgoing {Auto '}
Method for Session Refresh  |Reinvite -

1200

Media Connection Preservation [Dnsabled

[Caller D from From header

B

Send From In Clear

User-Agent and Server
Headers

Service Busy Response

503 - Service Unavailable v |

Action on CAC Location Limit | Allow Voicemail v]

e Set ITSP Domain Name to the IP address of CenturyLink signaling server (Usage Trunk
Group) 192.168.33.9.

e Check the In Service box.

e Set URI Type to SIP.

e Check the Check OOS box. With this option selected, IP Office will use the SIP OPTIONS
method to periodically check the SIP Line.

e Set Call Routing Method to Request URI.

e Check Caller ID from From header box.

e Set Send Caller ID to Diversion Header.

e Set Association Method to By Source IP address.

e Set Service Busy Response as 503 — Service Unavailable.

e Check REFER Support to enable SIP REFER for call transfers. Select the default values of
“Auto” for Incoming and Outgoing to use of SIP REFER effectively.

e Set Method for Session Refresh to Reinvite with Session Timer (seconds): 1200. If the
Method for Session Refresh set to the default value “On Demand”, then IP Office does not
initiate Session Timer and only supports it if it is initiated by the other side.

e Default values may be used for all other parameters.

e Click OK to commit (not shown) then press Ctrl + S to save.

IP Offices | Line = SIP Line - Line 18 o B X[ vi<l>
x BOOTP (5) Line Number ~ Line Type [SIP Line| Transport|siP URI|volP  [738 Fax|SIP Credentials|
f"—li) 2 Tl w s

:g&?) :__; 2’; t::: ‘ |nsp Domain Name 192168339 | ’[1: :T::: [:nj .

‘fﬂ g:::g?l)) Prefix [Check 00s |

s 32215?55 2 National Prefix ‘Call Routing Method Request URL Z ]

o RAS (1)
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On the Transport tab in the Details Pane, configure the parameters as shown below:

e The ITSP Proxy Address was set to the IP Address of CenturyLink signaling server (Usage
Trunk Group) 192.168.33.9.

¢ Inthe Network Configuration area, UDP was selected as the Layer 4 Protocol and the Send
Port was set to 5060 which is the port number provided by CenturyLink.

e The Use Network Topology Info parameter was set to LAN 2. This associates the SIP Line 18
with the parameters in the System = LAN2 - Network Topology tab.

e The Calls Route via Registrar was unchecked. In this certification testing, CenturyLink did
not support the dynamic Registration on the SIP Trunk.

e Other parameters retain default values.

e Click OK to commit (not shown) then press Ctrl + S to save.

= SIP Line - Line 18 e -

'SIP Line/[Transport] sip URI|VolP | 138 Fax|SIP Credentials

ITSP Proxy Address 192.168.33.9

Network Configuration

Layer 4 Protocol tUDP v | Send Port 5060
Use Network Topology Info ’ LAN 2 v | 5060
Explicit DNS Server(s) 0 0 0 0 0 0 0 0

Calls Route via Registrar [ l

Separate Registrar

A SIP URI entry must be created to match each outgoing number that Avaya IP Office will send on
this line. Select the SIP URI tab; click the Add button and the New Channel area will appear at the
bottom of the pane (not shown). To edit an existing entry, click an entry in the list at the top, and
click the Edit... button. In the example screen below, a previously configured entry is edited. For
the compliance test, a single SIP URI entry was created that matched any DID number assigned to
an Avaya IP Office user. The entry was created with the parameters shown below:

e Set Local URI, Contact, Display Name, and PAI to Use Internal Data. This setting allows
calls on this line which SIP URI matches the number set in the SIP tab of any User as shown
in Section 5.7.

e Set Registration to 0: <None> as CenturyLink does not require registration.

e Associate this line with an outgoing line group in the Outgoing Group field. This line group
number will be used in defining outgoing call routes for this line. For the compliance test, a
new outgoing group 18 was defined that only contains this line (line 18).

Note: For the specific inbound toll-free test, associate this line 18 with an incoming line
group in the Incoming Group field.
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e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.
e Click OK to submit the changes.

= SIP Line - Line 18
|SIP Line| Transport [SIP URI| VolP | 738 Fax|SIP Credentials
Channel Groups Via Local URI Contact Display Name PAI Credential Max Calls Add...
N.. 0:<Non.. 20
Remove
Edit...

Edit Channel
Via 10.10.98.14

Local URI Use Internal Data v Cancel
Contact v

Display Name v

PAI v

Registration [0: <None> v

Incoming Group 18

Outgoing Group 18

Max Calls per Channel 20 =

Select the Vol P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified. Selecting G.711 ULAW 64K, and
G.729(a) 8K CS —ACELP codecs causes Avaya IP Office to include these codecs, which are
supported by the CenturyLink, in the Session Description Protocol (SDP) offer, in that order.
Uncheck the VolP Silence Suppression box.

Check the Re-invite Supported box.

Check Codec Lockdown.

Set Fax Transport Support to T38 or G.711 from the pull-down menu. CenturyLink
support both Fax T.38 and Fax G.711 pass-through modes.
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e Set the DTMF Support to RFC2833 from the pull-down menu. This directs Avaya IP
Office to send DTMF tones using RTP events messages as defined in RFC2833.

e Default values may be used for all other parameters.

e Click OK (not shown) to submit the changes.

= SIP Line - Line 18

ek - | X | v

‘SIP Line]TransportlSIP URI| VoIP ‘T38 FaxISIP Credentials‘

[[] VolP Silence Suppressionl

[7] Allow Direct Media Path

v]l [[@] Re-invite Supported |

Codec Selection [Custom
Unused Selected
G.711 ALAW 64K N G.711 ULAW 64K

G.723.1 6K3 MP-MLQ

G.729(a) 8K CS-ACELP

[¥] Codec Lockdown

[T] PRACK/100rel Supported

Force direct media with phones

[] G.711 Fax ECAN

Fax Transport Support [G.711

Location [Cloud

Call Initiation Timeout (s) 4

| DTMF Support |RFC2833
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5.6. Short Code

Define a short code to route outbound traffic on the SIP line to CenturyLink. To create a short code,
select Short Code in the left Navigation Pane, then right-click in the Group Pane and select New
(Not shown). On the Short Code tab in the Details Pane, configure the parameters for the new short
code to be created. The screen below shows the details of the previously administered “5N;” short
code used in the test configuration.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 5N;, this short code will be invoked when the user dials 5 followed by
any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N”@192.168.33.9”. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The host part following the “@? is the IP address of CenturyLink
signaling server (Usage Trunk Group).

e Setthe Line Group ID to the Outgoing Group 18 defined on the SIP URI tab on the SIP
Line in Section Error! Reference source not found.. This short code will use this line group
when placing the outbound call.

IP Offices | Short Code i= 5N;: Dial
R BOOTP (5 Code Telephone Number Feature A ‘
2 ICFJ’%Ef;#OFIG) 9%20°N# N Set Hunt Group ‘ =
=)y ice_. Bsdch . " " . Code 4

L N@I92166339" il
1 Line () @XFNEOO 00 FNE Service Eesture {Dia, =
“=» Control Unit (4) = =
-4 Extension (29) Telephone Number  N"@192168.33.9
§ User(26) : -
2% Group (1) Line Group ID 18
gé Locale United States (US English) v
o RAS (1) Force Account Code []
Q Incoming Call Route (6)
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The feature of incoming calls from mobility extension to idle-appearance FNE (Feature Name
Extension) is hosted by Avaya IP Office. The Short Code FNEOO was configured with following
parameters:

e For Code field, enter FNE feature code as FNEOQO for dial tone.

e Set Feature to FNE Service.

e Set Telephone Number to 00.

e Set Line Group ID to 0.

e Default values may be used for other parameters.

IP Offices ‘ Short Code i= FNEO0O: FNE Service
R BOOTP (5) Code Telephone Number  Feature “11!| Short Code
J 9X*20°N# N Set Hunt Group
== IPO“Sf'CE-l 9X5N;  N'@192168339"  Dial Code ENE
2 System (1) x
-4 Line (4) PXFNE0O| 00 FNE Service Feature FNE Service v

<2 Control Unit (4)
4 Extension (29) Telephone Number 00
§ User(26) ¢ =
% Group (1 Line Group ID 4
8% Short Code (60) Locale United States (US English) v
@B Service 0
o RAS (1) Force Account Code |
e Incoming Call Route (6)

5.7. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.5. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is 4188. Select the SIP tab in the Details Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line. The example below
shows the settings for user 4188. The SIP Name and Contact are set to one of the DID numbers
assigned to the enterprise provided by CenturyLink. The SIP Display Name (Alias) parameter can
optionally be configured with a descriptive name. If all calls involving this user and a SIP Line
should be considered private, then the Anonymous box may be checked to withhold the user’s
information from the network.

IP Offices | User = 4188: 4188 k-8 X v -
* BOOTP (5) paime Bitension | Voice Recording | Button P i I Menu P i i Mobility I Group Membership [ Announcements | [SIP Personal Dire
¢ Qoo ) | ' : et , ‘
-4 gra130 4159 SIP Neme 7203624188

ey §ra100 4190

T4 Line () SIP Display Name (Alias) 7203624188

<= Control Unit (4) frFaxa1o1 4101

& Extension (29) - Digital 4192 4192 Contact 7203624188

i §ra107 4197

# Group ) :NoUse(

8% Short Code (60) p | Anonymous

B Senvice (0) $raRemoteManager
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One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User 4188. The Mobility Features and Mobile Twinning boxes
are checked. The Twinned Mobile Number field is configured with the number to dial to reach the
twinned mobile telephone, in this case 516139675206. Check Mobile Call Control to allow
incoming calls from mobility extension to access FNEOO (see Section 5.6). Other options can be set
according to customer requirements.

W
-

4188: 4188

ek -8 X|v|<]|>

Voice Recording | Button Programming I Menu Programming ‘ Mobility ! Group Membership | Announcements I SIP I Personal Dire ¢ | *

[T] Internal Twinning

<None>

Twin Bridge Appearances
Twin Coverage Appearances

Twin Line Appearances

[V] Mobile Twinning

Twinned Mobile Number
(including dial access code)

516139675206

Twinning Time Profile <None>

Mobile Dial Delay (secs) 2

Mobile Answer Guard (secs) |0

[ Hunt group calls eligible for mobile twinning
[7] Forwarded calls eligible for mobile twinning
[] Twin When Logged Out

[7] one-X Mobile Client

[¥] Mobile Call Control

[¥] Mobile Callback
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5.8. Incoming Call Route

An Incoming Call Route maps an inbound DID number on a specific line to an internal extension.

This procedure should be repeated for each DID number provided by service provider. To create an
incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in the
center Group Pane and select New (Not shown). On the Standard tab of the Details Pane, enter the
parameters as shown below:

e Set the Bearer Capability to Any Voice.
e Setthe Line Group ID to the Incoming Group 17 defined on the SIP URI tab on the SIP
Line in Section Error! Reference source not found..
Note: For the specific inbound toll-free test, associate incoming DID number to an incoming

Line Group ID 18.

e Set the Incoming Number to the incoming DID number on which this route should match.
e Default values can be used for all other fields.

IP Offices Incoming Call Route = 17 7203624188
R BOOTP (5) Line GroupID Incoming Number Destination \ 1\/05:& Recording | DestinationsA
{47 Operator (3) @17 7203624192 FNEOO = o
s -3 7203624101 FAX4191 \

'T'; Liy::(:;( ) D18 7203624193 4193 Bearer Capability [Any Voice =

t1

< Control Unit (4) 017 7203624189 4189 4189 Line Group ID 17 -
& Extension (29) @17 7203624190 4190 4190 \
3 & User (26) T 17 7203624188 4188 4188 || Incoming Number 7203624188

2% Group (1) @17 7203624197 VoiceMail ‘ -
-@% Short Code (60) Incoming Sub Address

Service (0

g RZr;l(cS( ) Incoming CLI

Q Incoming Call Route (6) tocals L ,]
&2 WAN Port (0) ! .
A‘B; Directory (0) Priority [1 - Low 'J
£ Time Profile (0)

@ Firewall Profile (1) Tag
-l IP Route (3)

&m Account Code (0) Hold Music Source [System Source 'J
% License (30) . :

¥ Tunnel (0) Ring Tone Override None v
-§3 UserRights (10)

On the Destination tab, select the destination extension from the pull-down menu of the Destination
field. In this example, incoming calls to 7203624188 on line 17 are routed to extension 4188.

X —

= 17 7203624188 [ Xiv|l<|>
} Standard | Voice Recording‘}; Destinations L =
' TimeProfile Destination Fallback Extension
» | Default Value |4188 4188 | -
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The incoming calls to DID number 7203624192 were configured to access FNEOO. The Destination
was appropriately defined as FNEOQO as below screenshot:

= 17 7203624192 gk -8 X|v|<]>
EStandard Voice Recordingi Destinations ’
TimeProfile Destination Fallback Extension
» | Default Value |FNEOD =] -

The incoming calls to DID number 7203624197 were configured to access VVoiceMail. The
Destination was appropriately defined as VVoiceMail as below screenshot:

= 17 7203624197 i e X| | =

‘ Standard [ Voice Recording‘ Destination;‘

' TimeProfile Destination Fallback Extension

} > Default Value lVoiceMaiI f v ’[ v

5.9. Save Configuration

Navigate to File = Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 27 of 32
SPOC 8/7/2014 ©2014 Avaya Inc. All Rights Reserved. CTLSipIP0O903



6. CenturyLink SIP Trunk Configuration

CenturyLink is responsible for the configuration of CenturyLink SIP Trunk Service. The customer
must provide the IP address used to reach the Avaya IP Office at the enterprise. CenturyLink will
provide the customer the necessary information to configure the SIP connection between Avaya IP
Office and CenturyLink. The provided information from CenturyLink includes:

e Fully Qualified Domain Name, IP address and port number used for signaling or media

through any security.
e DID numbers.
e CenturyLink SIP Trunk Specification.
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7. Verification Steps
The following steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start - Programs - IP Office - System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP line of interest from the left
pane. On the Status tab in the right pane, verify that the Current State for each channel
(The below screen shot showed 2 active calls at present time).

S Avaya IP Office System Status - IPOffice_1 (10.10.97.40) - IP500 V2 9.0.3.0 build 941

AVAYA

IP Office System Status

Help Snapshot LogOff Exit About

System
B & Alarms (

B Trunks
Line: 1

Active Calls: 2

28 00:00:46 Extn 4188, 4188 Connected 00:00:35 |

Line: 18 SIP 192.168.33.9

Connected 00:00:35 516139675206

29 00:00:15 Line: 17 SIP 192.168.33.8 Connected 00:00:13

[16139675205@6... [Extn 4190, 4190

Connected 00:00:13

-S Avaya IP Office System Status - IPOffice_1 (10.10.97.40) - IP500 V2 9.0.3.0 build 941

AVAYA

Help Snapshot LogOff Exit

System

& Alarms (3)

Ex (2n

B Trunks (4)
Line: 1

Locations

IP Office System Status

About
Status  Utilization Summary Alarms
SIP Trunk Summary
Peer Domain Name: 192.168.33.8
Resolved Address: 192.168.33.8
Line Number: 17
Number of Administered Channels: 20
Number of Channels in Use: 1
Administered Compression: G711Mu, G729 A
Silence Suppression: off
Layer 4 Protocol: ubP
SIP Trunk Channel Licenses: Unlimited

®-

REFER (Incoming and Outgoing), UPDATE (Incoming and Outgoing)

SIP Trunk Channel Licenses in Use: 2
SIP Device Features:

Channel URI CallRef CurrentState Timein State Remote Media Codec Connection Caller ID or

Other Party on Call

Direction of  Round Trip

Receive Jitter Receive Transmit Transmit

Number Gr... Address Type Dialed Digits call Delay Packet Los... Jitter Packet Los...
1 1 29 | Connected | 00:02:28 | 192.168.33.4 |[G711...| RTPRelay |161336752... Extn 4190, 4190 Incoming
2 Idie 2days 22:...
3 Idle 2days 22:...

-J Avaya IP Office System Status - IPOffice_1 (10.10.97.40) - IP500 V2 9.0.3.0 build 941

(=l |

AVAYA

Help Snapshot LogOff Exit

System

& Alarms (3)

Extensions (27)

B Trunks (4)
Line: 1
Line: 2
Line: 17

Ac alls

Locations

IP Office System Status

About

Status  Utilization Summary Alarms

SIP Trunk Summary
Peer Domain Name: 192.168.33.9
Resolved Address: 192.168.33.9
Line Number: 18
Number of Administered Channels: 20
Number of Channels in Use: 1

Administered Compression: G711Mu, G729 A

Silence Suppression: off

Layer 4Protocol: uop

SIP Trunk Channel Licenses: Unlimited . %
SIP Trunk Channel Licenses in Use: 2

SIP Device Features: REFER (Incoming and Outgoing), UPDATE (Incoming and Outgoing)

Channel URI CallRef CurrentState Timein State RemoteMedia Codec Connection Caller ID or

Other Party on Call

Direction of

Round Trip  Receive Jitter Receive Transmit Transmit

Number Gr... Address Type Dialed Digits cal Delay Packet Los... Jitter Packet Los...
1 0 28 Connected 00:03:21 192.168.33.4 [G711...| RTPRelay Extn 4188, 4188 Outgoing
2 Idle 2days 22:...
3 Idle 2days 22:...
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e Use the Avaya IP Office System Status application to verify that no alarms are active on the
SIP line. Launch the application from Start - Programs = IP Office - System Status on
the PC where Avaya IP Office Manager was installed. Select Alarm - Trunks to verify that
no alarms are active on the SIP line.

-S Avaya IP Office System Status - IPOffice_1 (10.10.97.40) - IP500 V2 9.0.3.0 build 941 =

AVAYA IP Office System Status

Help Snapshot LogOff Exit About

B System
B & Alarms (3) Select a line to display the alarm information

Conﬁglfrﬂhon ) Line Module / Slot / Type Port Number / Address / Domain Alarms
& service (1) & 1 Slot: 1 1 1
:_&k a 2 Slot: 1 2 1
ink (0) T P 192.168.33.8 0
Call Quality of Servi 3 SIP 192.168.33.9 0

TLS (0)
Extensions (27)
Trunks (4)

B Voicemail
B IP Networking
Locations

e Verify that a phone connected to the PSTN can successfully place a call to Avaya IP Office
with two-way audio.

e Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.
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8. Conclusion

CenturyLink passed compliance testing. These Application Notes describe the procedures required
to configure the SIP connection between Avaya IP Office and the CenturyLink as shown in Figure
1.

9. Additional References

[1] Avaya IP Office Document Library Release 9.0, Document number 15-604278 Issue 1,
September 2013

[2] Avaya IP Office 9.0.3 Installing IP500/IP500V2, Document number 15-601042 Issue 29f, 13
June 2014

[3] Avaya IP Office Manager Release 9.0, Document number 15-601011 Issue 09.03, 31 March,
2014

[4] Avaya IP Office 9.0 Softphone User Guide (Windows), Issue 07c, 24 February 2014

[5] Avaya IP Office Embedded Voicemail User Guide (IP Office Mode), Document number 15-
604067 Issue 13a, 13 February 2014

Product documentation for Avaya products may be found at: http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php? XMLFILE=manuals.
XxmI&TEMPLATE=pdf feed template.html

Product documentation for CenturyLink SIP Trunk may be found at: http://www.centurylink.com
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Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and ™
are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the
property of their respective owners. The information provided in these Application Notes is
subject to change without notice. The configurations, technical data, and recommendations
provided in these Application Notes are believed to be accurate and dependable, but are
presented without express or implied warranty. Users are responsible for their application of any
products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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